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1.1 Overview 

Wisconsin Department of Transportation (WisDOT) has implemented WisDOT 
Civil Rights Compliance, a state-of-the-art, software application for payment 
tracking and labor compliance management. This system is designed to fulfill and 
streamline various federal and state reporting and monitoring requirements. 

The system contains three major functionalities: 

1. Payment Tracking – tracking and reporting actual payment transactions by 
prime and subcontractors. 

2. Labor Compliance Management – provides electronic certified payroll and 
fringe benefit reporting by prime contractors and all subcontractors.  As of 
2007, only mega projects will use this functionality.  See the separate 
Payrolls Manual if this applies to your firm. 

3. Disadvantaged Business Enterprise Management – allows the four Unified 
Certification Program partners to share a database which can interact with 
the other functionalities. 

1.2 Subcontractor Sublet Assignments 

This functionality replicates the contents of the DBE Commitment from and the 
Sublet Assignment form.  The electronic data allows a hierarchical tier of 
subcontractors to outline which firm should receive payments from which higher-
tier firm.   

1.3 Payment Tracking 

The payment tracking functionality is designed to assist contractors and WisDOT 
to meet the reporting requirements of 49 CFR, Part 26.37. The web-based 
system allows WisDOT to track all actual payments made to contractors.  The 
payment tracking functionality facilitates this by allowing each contractor to 
manage its payment reporting on a contract-by-contract basis.  

Payment tracking is simple, easy to use, and cost effective methodology. 
Through the use of industry standard navigation techniques, drop down menus, 
pop-up calendars and easy-to-understand information boxes, the reporting 
payment transaction is easily accomplished. 

Prime contractors are required to report the information on payments made to all 
first-tier subcontractors and all DBE subcontractors utilized on the project. 
Subcontractors are responsible for confirming the payments they receive.  
Payment reports that relate to individual contractors are also available through 
the system.  
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2.1 Recommended Internet Settings 

Before using the application, we recommend that users update their Internet 
Explorer settings in order to improve and facilitate the use of the application.   

Pop-Up Blockers 

The WisDOT Civil Rights Compliance application uses pop-up windows.  In order 
to use the application, you may need to alter your pop-up blocker.  Hill Int’l 
recommends adding the following website to the allowed list in the pop-up 
blocker settings: https://app.mylcm.com/wisdot.  

Cache Settings 

Hill Int’l recommends that users change the cache setting to prevent web 
browsers from displaying “cached” (old) information.  

To edit these settings: 

1. Open Internet Explorer. 

2. From the “Tools” menu, select “Internet Options” to open the Internet Options 
window (Figure 1). 

3. In the Internet Options window, select “General Tab” (Figure 2). From the 
select “Browsing History” section select “Settings” to open the Settings 
window (Figure 3). 

4. Verify that the setting for “Check for newer versions of stored pages:” is set to 
“Every visit to the page.” If not, select this option and click “OK.” 

5. Click “OK” on the Internet Options window to complete cache settings update. 

 

Figure 1 - Tools Menu, Internet Options 

https://app.mylcm.com/wisdot
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Figure 2 - Internet Options Window 
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Figure 3 - Settings Window 

Security Settings 

Hill Int’l recommends adding the website address to the user’s “Trusted Sites” list 
on their computers. This will help the website load more quickly.  

To edit the security settings: 

1. Open Internet Explorer. 

2. From the “Tools” menu, select “Internet Options” to open the Internet Options 
window (Figure 1). 

3. In the Internet Options window click on the “Security” tab (Figure 4). 

4. Click on the “Trusted Sites” icon and then click on the “Sites…” button to 
open the Trusted Sites window (Figure 4). 

5. Type in the LCM website address, https://app.mylcm.com/wisdot, and click on 
“Add” and then click on “OK” to return to the Internet Options window (Figure 
5). 

6. Click “OK” on the Internet Options window to complete the recommended 
security settings update. 

http://app.mylcm.com/wisdot
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Figure 4 - Internet Options Window, Security Tab 

 

Figure 5 - Trusted Site Window 

 



Chapter 2 – Getting Started 

3/1/2013 Prepared by: Hill Intl. & WisDOT 8 

   

2.2 Logging in to WisDOT Civil Rights Compliance 

Open the Internet browser and type in the following website URL in the address 
bar and click the log in button (Figure 6): https://app.mylcm.com/wisdot  

Enter the User ID and Password into the fields listed and click “Submit” (Figure 
6).  

Note:  The password is case sensitive.  If is incorrect, you will see 
an error message. 

 

Figure 6 - Log in Screen 

2.3 Selecting a Project 

When you log in to the application, you will see a list of your projects by region on 
the left hand side of the screen.  You may also see red informational messages 
about payments or other tasks (Figure 7). 

Note: The project list is organized by the WisDOT regions 
(northcentral, northeast, northwest, southwest, or southeast). 

 

Figure 7– Log in Screen with Messages 

https://app.mylcm.com/wisdot
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Note:  You can return to the informational messages by clicking on the “Home” 
link located on the top right corner of the screen (Figure 8). 

 

Figure 8 – Click on the “Home” link screen 

You can select a project by clicking on the name of the region and then the 
project from the list (Figure 9).  The project name will then turn red and additional 
menu options will appear.  Clicking on the project name will clear the 
informational messages and display the CPR Log screen. 

Note:  If your firm is the prime on the project, you will see (prime) 
following the project id or name.  All other projects will indicate 
your firm is a subcontractor. 

Occasionally contractors are assigned to a project multiple times either by a 
single contractor or by multiple contractors.  In this case, clicking the project 
name will expand the list and show each assignment to the project identified with 
the name of the contractor assigning your firm. 

If the same contractor were to assign your firm multiple times, then each 
assignment will be given a number (0001, 0002, etc.)   

Note: Contractors at higher tiers must assign subcontractors to 
the project.  WisDOT then must approve the assignment.  If 
WisDOT has approved the assignment, the project will appear on 
the list of Active Projects, and your firm will receive an e-mail 
indicating this has taken place.  

 

 

Select project from list.  Once 
selected, project name will 

turn red. 
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Figure 9 - Selecting a Project Screen 

Note: The order you display projects is up to you.  Name or 
project id can be further arranged by changing to Project Start 
Date order.  You can use standard “Find” searches to seek your 
project. 

Projects will remain on your list until the projects final payment 
is entered and the project has “rested” for a year.  During this 
interim rest period, you may use the “Hide” feature to shorten 
the list. 

2.4 Customizing Your View Of Projects 

While working with projects, you have a few options for how you would prefer to 
have things displayed.  The default view is a list organized alphabetically by 
project description.  You could view projects by WisDOT project id and by start 
date as well. 

A radio button is presented both for the sort and the display item above the list of 
projects your firm is assigned to.  They appear in the light-blue projects box 
above the list of projects.  See Figure 8. 

You cannot clear projects from the Active Project list.  You may, however hide 
complete active projects by checking the box.  See Figure 9. 

2.5 Edit User Information 

Payment and sublet users may only edit their own information.  Additionally, 
administrators may use this feature to change the role of an existing user.   

To do this: 

1. From the Company menu bar at the top of the screen, click “Add/Edit user” 
(Figure 10).   

 

Figure 10 – Select Edit User Menu 

Click to Edit 
User 
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Figure 11- Add User Screen - Edit User 

2. Scroll to the bottom of the screen and click on “Edit User” (Figure 11). 

3. The following information can be edited/added (Figure 12).  Only 
administrative users can edit the user role. 

o Password 

o Full name 

o Title 

Note: Passwords may be alphabetic, numeric, or alphanumeric.  
They are required to be at least three and cannot exceed 20 
characters in length. 

User IDs cannot be edited.  If this information changes, someone 
with an administrator role will need to add a new user.  The 
unwanted user id can be disabled. 

If you misplace or forget your password, please refer to 
Appendix 1 – Customer Support. 

 

Figure 12 - Edit Payment or Sublet User Screen 

Click to edit user 
information 
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2.6 Logging out of WisDOT Civil Rights Compliance 

You may log out of the WisDOT Civil Rights Compliance System at any time by 
clicking “Logout” in the upper right-hand corner of the screen (Figure 13).   

  

Figure 13– Logout 

Click to Logout 



 Chapter 3 – Contractor Sublets 

3/1/2013 Prepared by: Hill Intl. & WisDOT 13 

   

CHAPTER 3 Contractor Sublets 

In This Chapter 

 

3.1 Introduction 14 

3.2 Reviewing Project Details 14 

3.3 Assigning Projects to Subcontractors 16 

3.4 Adding/Editing Subcontractor Contract Values 20 

3.5 Unassigning a firm 21 

3.6 DBE Commitment Report 21 

3.7 Current Sublet Becomes DBE Certified 23 

3.8 Review Bidder’s List 24 

3.9 Search Firms Error! Bookmark not defined. 

3.10 Review DBE UCP Directory 27 

3.11 Overall Trucking Schedule 29 

 



 Chapter 3 – Contractor Sublets 

3/1/2013 Prepared by: Hill Intl. & WisDOT 14 

   

3.1 Introduction 

Contractors complete DBE commitment forms and Sublet assignment forms for 
WisDOT to help identify what firms would be working on the project and what 
they would be doing. This system automates both of these functions, although 
WisDOT staff will continue to need you to submit both forms.  This system will 
not track the particular line items that the Trns*Port system uses. 

No subcontractor is able to enter payroll (for megaprojects only) or payment 
information until the sublet work has been completed for the lower-tiered firm.  
We suggest that primes enter all first-tier subcontractors, and have first-tier 
subcontractors enter any of their DBE firms, by the time you would normally 
submit the Sublet Assignment form to the regional office. 

Sublets happen as the project as getting started and at each phase along the 
construction of the project. As changes occur, WisDOT staff may revise the DBE 
commitment form for the project within the system. 

3.2 Reviewing Project Details 

The application stores information about each project that is available to all 
contractors working on that project.   

To view the project details: 

1. From the project list on the left side of the screen, select the project whose 
details you would like to review.  The project name will turn red and additional 
menu options will appear (Figure 14). 

 

Figure 14- Project Details Menu 

Click “Project Details” 
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2. From the Project menu select “Project Details;” this will open the Project 
Details screen (Figure 15). 

 

Figure 15 - Project Details Screen 

Note: The Local Information Address will be changed to reflect 
the project manager’s e-mail address.  You will need this contact 
for pre-approval of delaying any payments.  You may wish to 
know this if payments must be delayed or if payments are late in 
arriving. 

You can also very clearly see the project’s DBE goal, if one has 
been set.  All sublet assignments will be considered race 
conscious up to the point of meeting this goal. 
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3.3 Assigning Projects to Subcontractors 

(Admin and Sublet Users) 

This chapter outlines the steps to be in compliance with ASP3.  The awarding 
agency or their representative is responsible for assigning projects to prime 
contractors. Once the Bureau of Project Development has awarded a project to a 
prime, it will appear in the system a few days later. 

All contractors, at every level, must assign their subcontractors to the project.  
This includes DBE suppliers.  This will enable WisDOT to monitor prompt 
payments throughout the life of the project.   

A subcontractor may be assigned to multiple contractors on the same project.  If 
your firm is providing labor, this will require certified payrolls for each assignment. 

To perform this function: 

1. Select from the list of assigned projects the one to which you need to assign 
subcontractors. 

Note: The prime contractor must assign first-tier subcontractors 
before first-tier contractors can assign their own subcontractors. 
If the project(s) is not listed, contact WisDOT to determine the 
status (Refer to Appendix 1).  It may have to approve a 
subcontractor. 

2. Click “Assign Subcontractors” from the Project menu at the top of the screen.  
These firms may be expected to enter weekly payrolls, unless they are 
suppliers or owner/operators who work for a carrier firm (Figure 16). 

 

 

Figure 16 - Assign Subcontractors Menu 

3. A new screen will appear showing a list of available subcontractors and a 
list of assigned contractors.   

Select a project from list 

Click “Assign 

Subcontractor” 
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Figure 17 – Assigning Subcontractor(s) Screen 

Note: Since the Contractor Category is a large one, it will have a 
middle column to speed up locating firms as shown in Figure 17.  
Click on the starting letter to move to that section of the list. 

 In the Search box, you may type a few characters of the firm’s 
name to avoid having to scroll as much.   

Firms with expired registrations remain on the selection list.  
They will have to renew their registration before they record 
sublets or payment information. 

If a firm does not appear on this list, it means one of two things: 

- The firm may not consider itself a contractor 

- The firm is not registered (refer to Figure 6 for Registration 
link) 

4. If you need a Business Type other than Contractor, change the value in 
the drop down box. 

You will not see a contractor’s name if they have not registered 
in the system.  Please contact them and have them register.  
Firms like architectural consultants, design engineers, and 
geotechnical services may be found under Consultant.  Other 
Business Type will capture many DBE firms which are not 
obviously contractors. 

5. Enter the contract value into the box (Figure 18 or Figure 19).  Which type 
of screen appears depends on whether the firm is a DBE.  Save the 
assignment by clicking on “Assign.” 
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Figure 18– Add/Edit NonDBE Subcontract Amount 

 

Note: The contract value for 1st tier subcontractor must match 
the Request for Sublet form. The contract value listed for DBE 
subcontractors must be equal to the amount indicated on the 
“Commitments to Subcontract to DBE” form submitted with your 
bid.  Contract values should not include any bond amounts. 

For lower tiers, it is also helpful to report this information so the 
Commitments versus Actual Payments report will be accurate.  If 
you are unsure what the exact value is for trucking or supplies, 
please provide an estimated value in whole dollars based on the 
anticipated number of loads.  

6. For DBE firms, you may need to enter more information.  As shown on 
Figure 19, some functions may reflect race conscious choices, while 
others do not.  If the DBE goal is exceeded, you should divide the entry 
as shown in the figure.   

 

Figure 19– Add/Edit DBE Subcontract Data 
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Note:  Not every DBE will look this way.  Only trucking firms see 
the last 4 questions. 

If a DBE goal is exceeded ($ amount needed is negative), you 
should indicate the excess amount for the firm of your choice as 
Race Neutral.  Add another  Work Performed line as shown in 
Figure 19 by clicking on the “Add assignment.”  Use the red X’s 
to remove an assignment line if you were experimenting. 

Manufacturers should be Suppliers with a Type of Work of 
Material Supplier to get 100% credit.  They also must have 
registered by identifying themselves as a manufacturer. 

If entering a trucking firm, you may need to refer to section 3.11 
to see how many trucks the firm has available. 

 

 

Figure 20 – Pending Sublet Screen 

Note: Firm names will not appear in the column on the right until 
WisDOT staff have approved the firms for participation.  If you 
are in a hurry to see this, call the appropriate Equal Rights 
Officer.  They must have your Request to Sublet form first. 

You cannot unassign on incorrectly chosen firm until it has been 
approved.  You can however, modify the contract amount.  This 
link would appear under approving in Figure 20. 

 

7. The system will then send an e-mail that looks something like this. 
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From: <Civil Rights Administrator’s email > 
To: <hiring firm’s bidding contact’s email > 
CC: <SubContractors bidding contacts email> 
Subject:  SubContractor Assigned Notice for 2099-00-70  
 
SubContractor Assigned Notification 
 
Company   : Prime or hiring firm 
 
Has Assigned [your firm] as a SubContractor 
  
Project: Main Street, City of x (2140-00-00) 
 
All of our projects require mandatory electronic payrolls.  We also require 
payment confirmation so we can be sure our first-tier subcontractors and 
disadvantaged business enterprise firms are being paid promptly. 
 
If this subcontractor has any subcontractors on the project, it must enter 
sublet payments before those firms may enter payrolls or payment 
confirmations.  Most of our projects have at least two tiers of subcontractors 
 
Thank you, 
WisDOT Equal Rights Officers 
 

Adding/Editing Subcontractor Contract Values 

(Admin and Sublet Users) 

While $100 is an acceptable value for lower-tier firms, megaprojects receive a 
greater scrutiny.  You may be asked to update an amount. 

To add or edit subcontractor amounts: 

1. Select from the list of assigned projects the one to which you need to add or 
edit subcontractor contract amounts. 

2. Click “Assign Subcontractors” from the Project menu bar at the top of the 
screen (Figure 16).  

3. A list of all assigned subcontractors is shown on the right side of the screen 
(Figure 17). 

4. Click on “Edit.” 

5. If the firm appears in the column on the left with “approving” as a link, choose 
“Modify” under it. 
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3.4 Unassigning a firm  

To unassign a contractor, click on “unassign” and then click on “OK” to confirm 
(Figure 21). 

 Note:  The system will not allow a subcontractor to be 
unassigned if payrolls or payments have been submitted. 

 

Figure 21– Unassign Contractor 

Note:  If the firm is a Disadvantaged Business Enterprise, DBE, 
you must have permission before unassigning the firm.  The 
system will notify WisDOT staff.   

3.5 DBE Commitment Report 

The process of submitting the sublet serves as a DBE commitment within the 
system.  You may view the status of commitment report throughout the life of the 
project. 

1. From the Project menu, select “DBE Commitment Report.” 

 

 

Figure 22-Select DBE Commitment Report 

2. Review what has been approved, if anything. 
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3. Click on the next page symbol to scroll through the screen or select the 
printer icon on the gray menu bar to print the report. 

Note: This report, like many in the system, will appear in a pop-
up window.  Your browser must accept it or it will appear to 
“blink” and do nothing more.  You may hear a ping if the sound 
hasn’t been disabled.  You may also see a message about a pop-
up being blocked. 

 

 

Figure 23-DBE Commitment Report Screen 

Note:  Because the actual DBE Commitment Report is a paper 
form, DT1506, serves as the legal record for the project, this 
form and its attachments will always be needed.  The Bureau 
of Project Development maintains these forms on file.   The 
Equal Rights Officers will compare the form to what is entered 
online.   

Once the project has been executed, you should no longer 
have to submit revised DBE Commitment forms.  The system 
can generate them as you can see in Figure 22. 
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3.6 Current Sublet Becomes DBE Certified 

It is entirely possible that during the course of a project, an assigned firm could 
become DBE certified.  If this should happen, the system will send an e-mail to 
the bidding contact.  That note would look like this: 

 Subject: New DBE certified 

 CERTIFYING AGENCY has recently approved firm XXXXX as a DBE.  
Please revise these projects' sublets for this firm so you may receive credit for 
the use of a DBE: 

    project   region 

    xxxx-xx-xxxx  YY 

    xxxx-yy-zzzz  AA 

 

 Thank you. 

 WisDOT UCP 

If your firm wished to receive DBE credit for the firm, their assignment would 
need to be changed.  You may only receive credit if the firm’s work is not 
complete. 

1. Select the project which needs updating. 

2. Select "Assign Contractor" from the Project menu.  The Assigning 
Subcontractors screen will display (Figure 17). 

3. "Edit" the firm's assignment in the Assigned Contractors box on the right. 

 

Figure 24 – Click on Edit Screen 

4. The Assignment Info screen should now display a DBE assignment 
screen for this firm.  

5. Click on "Update." 
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Figure 25 – Add Type of Work/Contact Amount Screen 

3.7 Review Bidder’s List 

For years, firms have tried to contact one another with faxes and telephone calls 
to try to determine who may be interested in helping share the workload for 
delivering a particular WisDOT project.  Use of this system allows firms to now 
use electronic mail to assist in this effort.  

1. From the Reports Menu, click “Bidders List” to begin the search. 

 

 
Figure 26 – Select Bidder’s List 

 
Figure 27 – Basic Search for Bidders 
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2. Using this screen, you can search for a particular firm or firms, in a specific 
city, county or zip code, as well as identify whether you are seeking a race-
conscious or a race-neutral list of firms. 

 
Figure 28 – Advanced Search for Bidders 

3. Click on “Advanced Search Options” to specifically search for a firm by its 
type of work.   

Note: If you cannot find a firm you expect to see, call customer 
support; see Appendix 1.  WisDOT may need to tweak their Work 
Classification list.  This can be done under Company, on the 
main menu, then Company Profile. 

4. Select the categories and/or business type of firms you are interested in 
getting in touch with.  Click on the small boxes in front of each classification. 

5. Click on “Search.” 
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Figure 29 –Bidders List Search Results 

6. You may continue to refine your search criteria if you did not receive the 
results you expected.  Click on “Search Companies.” 

7. You have the options to print the list of firms meeting the criteria or exporting 
the data to an Excel spreadsheet file.    

Exporting:  Change the radio button to save “All” and identify a file type. 

 

Figure 30 –Select Bidder’s List Export Type 

8. To send an e-mail to these firms, click on the e-mail column of text and copy 
the values.  Paste these into an e-mail note; you may have to add either a 
comma or a semi-colon between which firm’s name, depending on your e-
mail system.  Consider whether or not you wish to send a note to several 
firms at once; if so, check your e-mail system’s documentation on how to 
send a Blind Carbon Copy message. 
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Figure 31 –Copy Bidders’ E-mail Addresses 

9. Click on “Home” to return to the CPR Log screen. 

3.8 Review DBE UCP Directory 

In many cases, viewing the Bidder’s List may answer all of your questions.  
However, when a firm is marked “Other Miscellaneous” for Work Classification, 
the DBE directory may be very helpful.  Do not use the directory if you are only 
interested in seeing one firm.   

This directory allows any Civil Rights Compliance System user the ability to see 
all of the currently-certified firms.  You have three choices of how to generate the 
list: 1) NAICS-code order, then by firm name, 2) simply by firm name, or 3) by 
work performed category. 

1. On the main menu UCP, click on “UCP Directory.” 
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Figure 32 – Select Criteria 

2. Click on “Work Classification” values. 

3. Check any of the codes you wish.  

4. Select the area(s) capable (regions) for UCP Directory (Figure 32).  

The best option is the default, if you want to see everyone. 

5. Change the Report Sorted by radio button as appropriate. 

6. Click on “Submit” 

7. You can navigate with the values in the column on the left or use the 
next page icon above the report headings. 

Note:  If you cannot see this report, your browser isn’t allowing 
pop-ups from this trusted site. 
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Figure 33- Search Results 

3.9 Overall Trucking Schedule 

Our DBE office each spring collects lease information between DBE Trucking 
companies and their peers.  No trucks are to be allowed on the jobsite unless 
they appear on this report. 

The Overall Trucking Schedule Summary provides a current view of all firms.  It 
will be obvious if they have not submitted a schedule. 

Unlike in the past when we mailed out letters to the firms saying that we 
approved their information, we are instead sharing this view of the data with the 
larger contracting world.   

1. From the UCP Menu, select “Overall Trucking Schedule”. 

 

Figure 34 - Select Overall Trucking Schedule 

2. Every DBE firm certified to perform either 484110, General Freight 
Trucking, Local or 484220, Specialized Freight (except used goods) 
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Trucking, Local will display on the report.  Leased truck counts will 
only appear if the firm has had its schedule approved. 

3. Please note that multiple pages are likely to generate, so you may 
need to scroll forward to view on the screen.  You can navigate 
through the list with the reports toolbar. 

 

Figure 35 – Approved WisDOT Trucking Schedules 

Note:  Only firms with approved submitted truck schedules 
should be assigned to projects. 

You may also select earlier years’ information.
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4.1 Introduction 

The Payment Tracking function is designed for contractors to record payments 
made to subcontractors irrespective of their tiers and to allow subcontractors to 
confirm the payments made by prime contractors to them in a secure web 
environment.  This chapter outlines the steps needed to be in compliance with 
ASP 7. 

This function may be used in conjunction with the WisDOT Construction Contract 
Payment Viewing System.  The Bureau of Project Development has worked with 
the contracting industry through the Electronic Bidding and Commerce 
workgroup (EBC) to develop a web application for contractors to view payment 
information. This Extranet application will allow individuals to view contract level 
payment estimate information for all vouchers on let contracts.  Subcontractors 
will be able to identify if their items of work have been paid.  

Once the estimate has been approved, WisDOT’s budget staff are notified they 
may issue a check release.  When the Department of Administration sends over 
the check two days later, an electronic file updates the Civil Rights Compliance 
System with the information about the check.  By the time the prime receives the 
check, the system should be ready to receive its acknowledgement of receipt and 
then can accept payments to subcontractors. 

Contractors must receive approval from their WisDOT project manager prior to 
withholding payment from any of their subcontractors.  See the Project Details 
(under Project) screen for the contact information. 

4.2 Reporting Payments to Subcontractors 

WisDOT requires that all payments to subcontractors, at any tier, be recorded in 
the application.  This will enable all DBE and trucking subcontractors to have the 
same protections of prompt payment that first-tier subcontractors enjoy. 

To record a payment to a subcontractor: 

1. From the project list, click on the project name or id for which a payment 
needs to be recorded. The name will turn red and project information will 
appear on the screen to the right of the project list. 

2. From the Payment menu, select “Payment to Contractor” (Figure 36). This 
will open the Contractor Payment Report (Figure 37). 
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Figure 36 - Payment to Contractor Menu 

3. Select the contracting firm’s name from the drop-down list for which you are 
reporting a payment. 

4. Enter the payment details.  All fields shaded yellow are mandatory. 

Note: The net amount will be calculated as the difference 
between the gross amount and the retainage.  Do not include 
bond amounts in this figure. 

The system will tell you the payment amount is invalid if you 
enter a “$” or a “,”.  You may not record a negative gross amount 
and a negative retainage at the same time; enter them as 2 
entries with the same check number. 

If you are entering a retainage payment, please note the 
following.  The gross amount may be $0, and the retainage 
amount should be negative.  On Aeronautics projects, add the 
retainage to the gross amount as they are recorded.  Negative 
reatinages will not be necessary. 

5. Select payment type from dropdown list.  Progress payment is the default for 
this field. 

6. Select awarding agency payment reference number from dropdown list.  This 
should be indicated on the payment contractor received from agency (for 
prime contractor) or from prime contractor (for subcontractor).  Refer to the 
payment log if you are unsure which payment reference number to use. 
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If you select an incorrect reference number, the payment may be 
incorrectly marked as late.  Be sure to select the correct 
reference number in order to eliminate this problem; the first 
reference number reflects the most recent one.  Refer to the 
Payment Thread if you are uncertain which reference number to 
use.  Each entry is dated. 

Select the work category from the dropdown list.  This category 
should best describe the type of work the contractor is being 
paid for in this payment. 

When trucker and supplier payments cannot easily be tied to a 
WisDOT payment, use the reference id ending “ST,” at the top of 
the list.  This id may not be used for other contractor types. Work 
assignments are also reviewed and must include Material 
Supplier, Other Miscellaneous, Aggregates, Equipment Supplier, 
Turbidity Barriers, or Vehicle Fuel/Supply. 

7. If the payment is being made late, select a reason from the dropdown list. 

Selecting a late payment reason will be mandatory if more than 
10 days have elapsed from receipt of payment to the release of 
payments to subcontractors.   

You must have written permission from the WisDOT project 
manager before deliberately withholding payment. 

8. You may include any other comments.  Uploading a copy of the check is 
discouraged. 

9. Click the “Submit” button to complete the payment or “Save as Draft” button 
to save and complete later. 

Note: You may edit a payment after submitting it, up to the time 
the subcontractor confirms it.  See Appendix 1 if a payment 
needs correcting for any reason. 
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Figure 37- Contractor Payment Report 

4.3 Confirming Payments 

If a contractor or WisDOT has recorded a payment to your firm, you will be 
notified as soon as you have logged in.  The screen will say, “You need to 
confirm a payment.” 

If you have received this message, click on the relevant project link to confirm 
receipt of check from a prime contractor or WisDOT.  Follow these steps to 
confirm payment. 

Select subcontractor 
from dropdown list 

Click “Submit” to 
complete payment 

report 

Select agency 
reference number 
and work category 

from dropdown lists. 

Click on calendar 
icons to select dates 

Select late reason from 
dropdown list if payment 
is issued more than 10 

days after receipt of 
referenced payment. 
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Figure 38 - Payment Log Menu 

1. You will see these lists of payment information in the payment log (Figure 
39): 

o Payment By – this contains a log of all payments your firm has 
made to its subcontractors 

o Payment To – this contains a log of all payments made to your 
firm from another contractor or WisDOT 

o WisDot Payments to Prime – this appears only if your firm is a 
subcontractor on a project 

o Payment Draft By – this contains a log of all payments recorded 
and saved, but not submitted, to your subcontractors.  You may 
need it if a reference number is not available. 

2. In the “Payment To” log, click on “Details” for the payment you wish to 
confirm.  This will open the Payment Details screen (Figure 40). 

 

Figure 39- Payment Log 

Click on 
“Details” in the 
“Payment To” 
list to confirm 

payment 
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Figure 40 - Payment Confirmation 

3. If you choose to dispute the payment, see the next section.  This will allow 
the payment to be changed.   

4. Type in the date the check was received or deposited in “Date” field.   

Note:  It is important that contractors indicate the date that they 
received the check as opposed to the date that they are using the 
application to confirm the payment. 

5. Click the “Confirm this Payment” button to confirm payment and submit. 

4.4 Disputing Payments 

Many reasons arise for disputing a payment.  It may be to the wrong contractor.  
The retainage could be incorrect.  It could be tied to the wrong reference number.  
The net amount could be wrong.  The check never arrived.  The payer will be 
able to alter the payment only if it has not been confirmed. 

1. Rather than clicking “Confirm this Payment”, click on “Dispute This 
Payment.” 

Please do not 
use these 

features 

Enter date payment 
was received and 

click “Confirm this 
Payment” 
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Figure 41 – Click on Save this Payment Dispute 

2. Identify your reason in the box. 

3. Click on “Save this Payment Dispute.” 

When you dispute a payment, the hiring firm will receive a message that 
the payment has been disputed. 

 

4.5 Reviewing Payments 

This can be used to review previously-confirmed payments shown in the 
Payment Log. 

1. From the project list, click on the project name for which you want to review a 
payment. The name will turn red and project information will appear on the 
screen to the right of the project list. 

2. From the payment menu, select Payment Log (Figure 38). You will see three 
lists of payment information in the payment log (Figure 39):  

o Payment By – this contains a log of all payments your firm has 
made to its subcontractors 

o Payment To – this contains a log of all payments made to your 
firm from another contractor or WisDOT 



 Chapter 4 – Payment Tracking 

3/1/2013 Prepared by: Hill Intl. & WisDOT 39 

   

o Payment Draft By – this contains a log of all payments recorded 
and saved, but not submitted, to your subcontractors 

3. Click on “Details” for the payment you wish to review.  This will open the 
Payment Details screen (Figure 42). 

 

Figure 42 - Payment Report 

4. Click on “Delete” for the payment you wish to remove.  This will open the 
Payment Details screen (Figure 42). 

 

Click “Delete”  
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Figure 43– Delete Unconfirmed Payment 

 
Figure 44 – Confirm Payment Deletion 

4.6 Unconfirming Payments 

If you entered incorrect data and the payment has been confirmed, contact 
Customer Support using the Questions? Link at the foot of any page.  Identify the 
project and payment. 

4.7 Uploading Payments 

Some firms may find the burden of hand entering all of the payment information 
into the system burdensome.  In that case, you will want to use this feature to 
export from your system or individually key them into a spreadsheet.   

Not all of the information needed for recording a payment is contained on this 
spreadsheet.  You will find a draft payment for each entry which must have the 
contractor, reference number, work category, and late reason (if applicable) 
entered. 

Note: Unless your firm has subcontractors, you will not be able 
to use this feature.  It cannot be used to record payment receipt. 
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Figure 45- Select Payment Import 

1. From the Payment menu, select “Payment Import.” 

2. Scroll the Browse button to locate the payment file you have created. 

3. Click on “Submit” to import the file. 

 

Figure 46- Identify Location of Payment Import File 

Your file must contain the following fields, in this format, to be successfully 
imported. 

 

Figure 47- Sample Import Payment File Layout 

Note:  The column headings must be present, and the file must be 
saved as an Excel file (xls). The Work Categories have a finite list of 
options.  See the Payment to Contractor screen for options.  It is 
permissible to use Other Miscellaneous as WisDOT does. 

If the system likes some of the data but not all, the payment will become a draft 
payment.  This could be true if it doesn’t have an exact match on the paid To firm 
name an invalid reference id or on the rare chance that a firm is assigned twice 
by the same firm for the project.  It will reject the payment if it cannot find a work 
category.  All fields must have some values. 

If the project id cannot be found, the payment will be rejected. 
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4.8 Commitments v. Actual Payments Report 

When contractors assign subcontractors to a project using the application they 
have the option to provide the initial contract amount.  Users are able to monitor 
the payments to subcontractors against actual payments by generating the 
Commitment v. Actual Payment Report.  To do this: 

1. From the Reports menu, scroll down to “Payment Related” and select 
“Commitment v. Actual Payments Report” (Figure 48). 

 

Figure 48 - Commitments v. Actual Payments Report Menu 

2.   The commitments v. actual payments report selection screen will open 
(Figure 49).  On this screen, select the following to customize the output of 
the report: 

 Region - Select from the dropdown list. 

 Project Name – Select from the dropdown list. 

 Period – period during which you want to view actual payments.  The 
default dates are start of the project and the current date. 

 Select Contractors – select the contractors whose payments you want to 
monitor. 

 Select Payments – choose to view all payments, confirmed payments or 
non-confirmed payments only. 

 Add Optional Columns – this allows you to add one or more additional 
columns of information to the report.  

Select “Commitments 
v. Actual Payments 

Report” from Reports 
menu 
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Figure 49 - Commitments v. Actual Payments Report Selection Screen 

3. After selecting the report criteria, click “Submit” to generate the report. 

4. After viewing the report, click “Print” to print or close the window to close the 
report. 

4.9 Unconfirmed Payments 

This report which is meant to help all “primes” ensure their subcontractors are 
confirming payments.  If the firm is lower than a first-tier subcontractor and does 
not have a DBE firm lower in its chain, any unacknowledged payments can be 
ignored.  You may want to make this report available at project meetings. 

1. From the Report Menu, scroll down to Payment Related and select 
“Unconfirmed Payment Report.” 

 

Figure 50 – Select Unconfirmed Payment Report Screen 

2. The Unconfirmed Payment Report Screen will appear (Figure 51). On this 
screen, select the following to customize the output of the report: 

 Region – Select from the dropdown list.  This alphabetizes the project 
list. 
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 Project Name – Select from the dropdown list.  You can see all 
projects for region as well. 

 Period – period during which you want to view actual payments.  The 
default dates are start of the project and the current date. 

3. After selecting the report criteria, click “Submit” to generate the report.  

 

 

Figure 51 – Unconfirmed Payment Criteria Screen 

4. After viewing the report, click “Print” to print or close the window to close 
the report. 

 

 

Figure 52 – Unconfirmed Payment Report 
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Appendix 1  Customer Support 

Questions 

Paul Ndon will be available as support to you with any questions you may have 
getting started, entering payroll, or reporting payment information.  You may 
contact him via phone (414) 438-4584 or e-mail (paul.ndon@dot.wi.gov).   

If sending an e-mail, please be sure to include the following information in 
addition to your question. 

o Project Name

o Company Name

Forgotten User Names or Passwords 

If you forget your user name or password, please call Paul Ndon to extract or 
update your firm's log in credentials.

Timing Out 

For security purposes, the application will log you out after 20 minutes idle time. 
If you receive an error message after leaving the application unattended for a 
while, try logging out and logging back in to the application.  If an error persists, 
refer to the following section for how to report errors. 

Reporting Errors 

If you encounter an error while using the system and in reviewing your steps 
believe that you have done everything correctly, please follow the steps below.  
A sample error screen follows. 

******************************************************************************************** 
Server Error in '/WISDOT' Application.  

Input string was not in a correct format. 

Description: An unhandled exception occurred during the execution of the current web request. 
Please review the stack trace for more information about the error and where it originated in the code. 

Exception Details: System.FormatException: Input string was not in a correct format. 

Source Error: 
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An unhandled exception was generated during the execution of the current web request. 

Information regarding the origin and location of the exception can be identified using the 

exception stack trace below. 

Stack Trace: 

******************************************************************************************** 
This screen contains one key line. That is the text above “Description.”  In this 
case, “Input string was not in a correct format.”  This means a date might not 
be in date format or a dollar amount has incorrect punctuation like a comma 
or a period without a following digit. 

Other error messages are generally in red text or in a display box.  Hopefully 
they will be self-explanatory. 




